โปรแกรม Macromedia Authorware 7.0

แนะนำโปรแกรม 
โปรแกรม Macromedia Authorware 7.0  เป็นโปรแกรมที่ใช้เป็นเครื่องมือซึ่งมีขีดความสามารถในการสร้างงานนำเสนอที่ต้องการ  ให้มีการตอบสนองระหว่างโปรแกรมกับผู้ใช้โปรแกรมได้หลากหลายรูปแบบในรูปของภาพ (Graphics),วิดีโอ(Video), เสียง (Sound), ภาพเคลื่อนไหว (Animation), ข้อความตัวอักษร (Text) เป็นสื่อการสร้างบทเรียนคอมพิวเตอร์ช่วยสอน (CAI) ที่สมบูรณ์
ประเภทของคอมพิวเตอร์ช่วยสอน
การแบ่งประเภทบทเรียนคอมพิวเตอร์ช่วยสอน

บทเรียนคอมพิวเตอร์ช่วยสอน มีหลายรูปแบบด้วยกัน ซึ่งการแบ่งรูปแบบหรือประเภทของบทเรียนคอมพิวเตอร์ช่วยสอนด้วยคอมพิวเตอร์ โดยสรุปแล้วมี 5 รูปแบบด้วยกันคือ การสอน (Tuturial ) ฝึกหัดปฏิบัติ (Drill and Practice) สถานการณ์จำลอง (Simulation ) เกมส์ (Games) และการทดสอบ (Tests) 



1.  การสอน (Tutorial) บทเรียนคอมพิวเตอร์ช่วยสอนประเภทนี้ จะเป็นสอนสิ่งใหม่ให้แก่นักเรียน คอมพิวเตอร์จะเป็นเหมือนครูสอนนักเรียนเป็นรายบุคคล บทเรียนคอมพิวเตอร์ช่วยสอนก็จะต้องดำเนินตามขั้นตอน วิธีการสอนหน่วยหนึ่งๆ เหมือนกับครูสอนในห้องเรียนคอมพิวเตอร์ช่วยสอน ส่วนใหญ่จะใช้ลักษณะนี้ เพราะจะใช้กับวิชาใดก็ได้จะสอนอะไรก็ได้เช่นกัน


2.  ฝึกหัดและปฏิบัติ (Drill and Practice) การใช้คอมพิวเตอร์ช่วยสอน เพื่อฝึกหัดและปฏิบัตินั้น จะใช้หลังจากการเรียนรู้สิ่งใหม่แล้วอาจจะเรียนจากการสอน หรืออาจจะเรียนจากเอกสาร หนังสือหรือสื่ออื่นๆ ก็ได้ การฝึกหัดและการปฏิบัตินี้ใช้ได้เกือบทุกสาขาวิชาไม่ใช่เพียงแต่สอนเลขคณิตกับคำศัพท์ ซึ่งบทเรียนจำนวนมากที่ทำในสองวิชานี้ แต่ยังอาจจะใช้ฝึกหัดวิชาอื่นๆได้ เช่น ภูมิศาสตร์ ประวัติศาสตร์ วิทยาศาสตร์ เป็นต้น


3.  แบบสร้างสถานการณ์จำลอง (Simulation) เพื่อใช้สำหรับการเรียนรู้ หรือทดลองจากสถานการณ์ที่จำลองจากสถานการณ์จริง ซึ่งอาจจะหาไม่ได้หรืออยู่ไกล ไม่สามารถนำเข้ามาในห้องเรียนได้ หรือมีสภาพอันตราย หรืออาจสิ้นเปลืองมากที่ต้องใช้ของจริงซ้ำ ๆ สามารถใช้สาธิตประกอบการสอน ใช้เสริมการสอนในห้องเรียน หรือใช้ซ่อมเสริมภายหลังการเรียนนอกห้องเรียน ที่ได้ เวลาใด ก็ได้


4.  แบบเกมส์ (Games) เกมส์คอมพิวเตอร์ แบ่งออกเป็น 2 กลุ่มใหญ่ๆ ได้แก่ เกมส์เพื่อการสอนและเกมส์ที่ไม่ใช่เพื่อการสอนหรือเป็นเกมส์บันเทิง


5.  ทดสอบ (Tests) การใช้คอมพิวเตอร์เพื่อการทดสอบ หรือประเมินผลนักเรียน ทำได้ 2 วิธี คือการใช้คอมพิวเตอร์เป็นเครื่องมือในการสร้างข้อสอบ และการใช้คอมพิวเตอร์ในการบริหารงานทดสอบหรือในการจัดสอบ



5.1  การใช้คอมพิวเตอร์เป็นเครื่องมือในการสร้างข้อสอบ โดยทั่วไปมักจะใช้โปรแกรมคอมพิวเตอร์ เพื่ออำนวยความสะดวกในการเชื่อมคำถามและคำตอบ นอกจากนี้ยังสามารถจัดเก็บในลักษณะเป็นคลังข้อสอบได้อีกด้วย



5.2  การใช้คอมพิวเตอร์ในการบริหารงานทดสอบ ครูสามารถเลือกหรือสุ่มข้อสอบที่ต้องการออกมาใช้เป็นแบบทดสอบได้
กระบวนการออกแบบและสร้างบทเรียนคอมพิวเตอร์ช่วยสอน
กระบวนการออกแบบและสร้างบทเรียนคอมพิวเตอร์ช่วยสอน จะแบ่งขั้นตอนการพัฒนา ดังนี้
ขั้นที่ 1 การออกแบบโปรแกรมบทเรียน (Courseware Designing) 
ขั้นที่ 2 การสร้าง Storyboard ของบทเรียน
ขั้นที่ 3 การสร้างโปรแกรมบทเรียน(Courseware Construction)

ขั้นที่ 4 การตรวจสอบและประเมินผลก่อนนำไปใช้งาน
การเรียกใช้โปรแกรม Authorware
1.เลือก Start ---> Programs ---> Macromedia Authorware(ตำแหน่งของโปรแกรม)
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2. จะปรากฏหน้าจอการทำงานของ Macromedia Authorware ขึ้นมา
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ส่วนประกอบของหน้าจอโปรแกรม
1. Menu Bar : ที่เป็นส่วนประกอบด้วยเมนูโปรแกรม Authorware มีทั้งหมด 11 เมนู
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2. Tool Bar : เป็นปุ่มคำสั่งแถบเครื่องหมายคล้ายกับโปรแกรมมาตรฐานทั่วๆไป ที่ไปรันบน Windows
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3. Icon Palette : เป็นเครื่องมือที่ใช้ในการสร้างงานในโปรแกรม Authorware ซึ่งสัญลักษณ์แต่ละตัวใช้แทนคำสั่งดังตาราง
	ชื่อไอคอน
	ความหมาย(Description)
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       Display icon


	ใช้ในการสร้างและแสดงผล  text และ graphics รูปภาพต่างๆ
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        Motion  icon


	ใช้สร้างการเคลื่อนที่ให้กับวัตถุไปยังตำแหน่งในแนวเส้นตรงหรือเส้นโค้งมี 5 รูปแบบ
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        Erase icon


	ใช้ลบวัตถุที่แสดงผลหน้าจอ เช่น ข้อความ รูปภาพ และภาพเคลื่อนไหว
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        Wait  icon


	ใช้หน่วงเวลาหรือหยุด (pauses) เวลาการแสดงผลหน้าจอภาพตามระยะเวลาหรือเงื่อนไขที่กำหนด
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          Navigate icon
	ใช้เชื่อมโยงไอคอนต่างๆ ที่อยู่ในไอคอน Framework  ด้วยปุ่ม next, previous, first หรือ last page ได้
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         Framework  icon
	ใช้สร้างโครงสร้างหลักลิงค์หรือพลิกไปยังหน้าต่าง ๆ  ของไอคอนที่แสดงผล text, graphics, sound, animation และทำงานร่วมกันกับไอคอน Navigate
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           Decision icon
	ใช้กำหนดเงื่อนไขและเหตุการณ์ว่าให้ทำงานตามลำดับ สุ่ม หรือระบุเจาะจงตามค่าที่กำหนดตัวแปร
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         Interaction icon
	ใช้สร้างการโต้ตอบระหว่างโปรแกรมกับผู้ใช้  มีด้วยกัน  11  รูปแบบ
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         Calculation  icon
	ใช้กำหนดค่าตัวแปร ฟังก์ชั่น และเขียน Script 
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         Map icon
	ใช้รวมไอคอนให้มีขนาดเล็กลง  มีโครงสร้างการวางไอคอนมากกว่าหนึ่งระดับ
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        Digital movie icon
	ใช้แสดงภาพเคลื่อนไหว ไฟล์พวก AVI, MOV, MPEG พวกไฟล์วิดีโอต่างๆ
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         Sound icon
	ใช้แสดงพวกเสียง  AIFF, MP3, PCM, WAVE  หรือ VOX
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DVD icon
	ใช้แสดงไฟล์ในรูปแบบของ DVD แต่ต้องมี DVD  Drive และ Microsoft DirectX version 8.1 หรือสุงกว่านี้
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   Knowledge Object icon
	เป็น Wizard ซึ่งโปรแกรมได้ออกแบบไว้ให้เพื่อใช้สำหรับสร้างงานอย่างรวดเร็ว
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        Start and stop flags
	ใช้กำหนดตำแหน่งทดสอบรันโปรแกรมเป็นส่วนๆ  เพื่อความสะดวกไม่ต้องทดสอบตั้งแต่ไอคอนแรกจนถึงไอคอนสุดท้าย  ปกติแล้วทั้งสองไอคอนนี้จะใช้คู่กัน
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       Icon color palette


	ใช้กำหนดสีของไอคอนเพื่อความสะดวกในการแยกแยะไอคอน ให้มองเห็นความแตกต่างของไอคอนได้ชัดเจนมากยิ่งขึ้น


4. Design Windows : เป็นพื้นที่สำหรับวางไอคอน ที่อยู่ใน Icon Palette ลากมาวางบนเส้นตรงที่เรียกว่า Flowline ถ้ามีพื้นที่  Design Window  เต็มดังรูป  ให้แก้ปัญหาโดยการ คลิกขวาและเรียกใช้  Scroll bars  จะปรากฏแถบให้เราเลื่อนดู
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5. Presentation  Window : เป็นพื้นที่แสดงผลงานที่ได้จากออกแบบไว้ใน  Design window สามารถกำหนดคุณสมบัติในเรื่องของขนาดพื้นหลังหรือเมนูที่ต้องการแสดง ได้ตามต้องการโดยคลิกเลือกที่เมนูคำสั่ง Modify>File>Properties ดังรูป
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เริ่มต้นสร้างงานนำเสนอด้วย Authorware
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  Display Icon  เป็นไอคอนที่ใช้สำหรับแสดงผลทางจอภาพ แสดงตัวอักษร แสดงภาพ แสดงภาพเคลื่อนไหวการใช้งานไอคอนนี้
ให้ใช้เม้าส์คลิกรูปไอคอนนี้บนแถบเครื่องมือค้างไว้ลากมาวางบนเส้นผังงาน
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ดับเบิลคลิกเปิดหน้าต่างไอคอนแสดง หน้าต่างนี้ประกอบด้วย คอนโทรลบ็อก แถบคำสั่งกล่องเครื่องมือ
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การวาดรูป คลิกเมนู Window เลือก Inspectors เลือก Colors
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ได้หน้าต่างกล่องสี คลิกอุปกรณ์ในกล่อง คลิกเลือกสี แล้ววาดรูป จะได้รูปตามต้องการ
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การพิมพ์ตัวอักษรและข้อความ
ใน Display Icon สามารถพิมตัวอักษร ใส่รูป วาดเส้นตรง วงกลมรุปสี่เหลี่ยมต่างๆ ได้โดยใช้เครื่องมือจาก Toolbox เมื่อต้องการพิมพ์ข้อความ ก็เพียง  
1. ดับเบิ้ลคลิกที่ไอคอน Display Icon 

2. คลิกเลือกรูปแบบที่ต้องการ
3. คลิกวางเม้าส์ที่บริเวณที่ต้องการแล้วทำการพิมพ์ข้อความตามที่ต้องการ
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การกำหนดลักษณะอักษร ขนาด และการจัดรูปแบบตัว 
1. คลิกเลือก Object ที่ต้องการเปลี่ยน จะปรากฏ Handle 

2. คลิกเมนู Text เพื่อเลือก Font เลือกที่ Other เพื่อทำการปรับเปลี่ยน 
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3. ถ้าต้องการกำหนดลักษณะตัวอักษรให้เลือก Style 
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4. ถ้าต้องการเปลี่ยนขนาดตัวอักษรให้เลือก Text Size
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5. ถ้าต้องการปรับตำแหน่งของข้อความให้เลือก Alignment
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การใช้เครื่องมือวาดใน Toolbox  

เราสามารถเลือกรูปแบบการวาดรูปได้ โดยเลือกที่ Toolbox แล้วทำการวาดที่ตำแหน่งที่ต้องการ  
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การสร้างและการพัฒนางานให้น่าสนใจ
ความหมายและการใช้คำสั่ง Transition 

    
 คำสั่ง Transition มีผลต่อการเริ่มปรากฏภาพ และการเปลี่ยนภาพ การใส่ Transition เพื่อให้การแสดงภาพในแต่ละเฟรมน่าสนใจ  
การใช้คำสั่ง Transition สามารถทำได้ ดังนี้  
1. คลิกเลือก Object ที่ต้องการเปลี่ยน จะปรากฏ Handle 

2. คลิกเมนู Modify เพื่อเลือก Icon เลือกที่ Transition
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3. จะปรากฏ Box ให้เลือกกำหนดลักษณะตามที่ต้องการ 
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การใช้คำสั่งต่างๆ ที่สำคัญและใช้งานบ่อย 
- คำสั่ง Inport รูปภาพ ทำได้ 2 วิธี คือ  
  

   1. Insert ---> Image 

    

    2. File ---> Inport

- คำสั่ง Group และ Upgroup

   ใช้ในการรวมกลุ่ม หรือยกเลิกการรวมกลุ่ม ทำได้โดย
     


Modify ---> Group หรือ Upgroup

                           - คำสั่ง Copy และ paste  

     

     Edit ---> Copy  

                                Edit ---> Paste 
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 Motion Icon เป็นไอคอนสำหรับทำให้สิ่งที่อยู่ข้างหน้าเคลื่อนไหวตามรูปแบบที่กำหนดการใช้งานไอคอนสร้างการเคลื่อนไหว 
คลิกลากไอคอนนี้มาต่อจากไอคอนแสดงที่มีสิ่งที่ต้องการทำให้เคลื่อนไหวอยู่บนเส้นผังงาน
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คลิกเมนู Control เลือก Restart ได้หน้าต่างกำหนดการเคลื่อนไหว
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คลิกวัตถุค้างไว้ รูปวัตถุจะเข้าไปอยู่ในช่องแสดง ลากวัตถุไปยังตำแหน่งที่ต้องการ
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ถ้าต้องการเปลี่ยนแบบการเคลื่อนไหว ให้ใช้เม้าส์คลิกปุ่มเปิดแบบการเคลื่อนไหวขึ้นมาให้เลือก กำหนดความเร็วจากตัวเลขในช่อง Timing ค่ามากเคลื่อนไหวช้า แล้วกดปุ่ม Preview ทดลองการเคลื่อนไหว แล้วคลิกปุ่ม OK 
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Erase Icon เป็นไอคอนสำหรับสั่งให้ภาพบนจอหายไปเพื่อแสดงภาพใหม่การใช้งานไอคอนลบหน้าจอ 
ใช้เม้าส์คลิกไอคอนนี้บนแถบเครื่องมือลากมาวางต่อจากไอคอนส่วนที่ต้องการจะลบออก
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คลิกเมนู Control คลิกแถบ Restart เพื่อทดลองให้แสดงการทำงานของโปรแกรม
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การแสดงจะหยุดที่หน้าต่างลบหน้าจอ ให้ท่านคลิกสิ่งที่ต้องการลบ ไอคอนสิ่งเหล่านั้นจะหาย ไปจากหน้าต่างลบจอ เลือกแบบการหายไปของวัตถุ( Transition)
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เสร็จแล้วกดปุ่ม Preview ทดลอง แล้วกดปุ่ม OK
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 Wait Iconใช้สำหรับทอดระยะเวลาให้โปรแกรมแสดงผลออกทางจอภาพหรือทำงานอย่างใดอย่างหนึ่งให้สำเร็จก่อนจึงทำงานต่อไป
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การใช้งานไอคอนหน่วงเวลา 
คลิกลากไอคอนหน่วงเวลามาวางหลังกลุ่มไอคอนที่ทำงานชุดที่จะหน่วงเวลา 
ดับเบิลคลิกไอคอนหน่วงเวลาจะได้หน้าต่างหน่วงเวลา เลือกรายการที่ต้องการ
[image: image29.png]Dssts
Saebyes

Fet.bylameiio
8 7 KeyPress

Timevimit [ Seconds

Gpions: [ Show Codoun
¥ showButon





เมื่อให้โปรแกรมทำงานจะแสดงปุ่มกดตามที่กำหนด
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Framework Icon เป็นไอคอนสำหรับรวบรวมงานที่แสดงเป็นแผ่นภาพต่อ ๆ กันหรือเอกสารต่อ ๆ กัน แบบหนังสือ โดยมีเครื่องมือสำหรับเปิดเดินหน้า ถอยหลัง ค้นหา ฯลฯ 
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ดับเบิลคลิกเปิดหน้าต่างแก้ไขระบบเฟรมงาน ตัดหรือเพิ่มได้
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การเพิ่มปุ่มของระบบ ลากไอคอนสามเหลี่ยมคว่ำ มาวางบนผังปุ่มของระบบ แล้วดับเบิลคลิ๊ก ไอคอนนี้ จะได้หน้าต่างสำหรับกำหนดการทำงานของปุ่ม
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การย่อขยายปุ่มกดของระบบ ดับเบิลคลิกไอคอนแสดงบนผังงานภายในเฟรมงาน จนได้หน้าต่างมีรูปของแถบปุ่มกด ใช้เม้าส์ลากปุ่มสี่เหลี่ยมเล็ก ๆ รอบรูปให้มีขนาดตามต้องการ 
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 การกำหนดไอคอน Decision และ Interaction
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  Decision Icon ใช้สำหรับให้โปรแกรมเลือกตาม เงื่อนไข หรือ สุ่ม หรือ ฯลฯ การใช้งาน 
- คลิกลากไอคอนทางเลือก มาวางบนเส้นผังงาน 
- คลิกลากไอคอนแสดงมาวางต่อจากไอคอนทางเลือกถัดไปทางขวา 2อัน
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- ดับเบิลคลิกเปิดไอคอนแสดงออกมาใส่ข้อมูลทีละอัน เช่น ใส่วงกลม กับสี่เหลี่ยม 
- ดับเบิลคลิกไอคอนทางเลือกเพื่อใส่รายการตามที่ต้องการให้ทำงาน
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- เมื่อโปรแกรมทำงานจะกระพริบเลือกระหว่างรูปวงกลมกับสี่เหลี่ยมจนนาฬิกาบอกหมดเวลา
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 Interaction Icon เป็นไอคอนสำหรับให้ผู้เรียนตัดสินใจเลือกทางเดินของโปรแกรมตามต้องการการใช้งาน 
- คลิกลากไอคอนตัดสินใจมาวางบนเส้นผังงาน 
- คลิกลากไอคอนแสดงมาวางต่อจากไอคอนตัดสินใจไปทางขวา 2 - 3 อัน 
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- ดับเบิลคลิกเปิดไอคอนแสดงเพื่อใส่ข้อมูล เช่น วงกลม สี่เหลี่ยม กากะบาด 
- คลิกปุ่มเล็กๆเป็นปุ่ม Response Type ได้หน้าต่างให้เลือกรายการที่ต้องการ เช่น PauseBeforeExit , Don't Erase เป็นต้น  
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- คลิกปุ่ม [image: image42.png]


 บนหน้าต่าง Properties : Response ทำเหมือนกันทุกทางเลือกดับเบิลคลิกไอคอนตัดสินใจ ได้หน้าต่างแสดงผล จัดตำแหน่งของปุ่มกด ทางเลือกและแก้ใขรูปแบบต่าง ๆ
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- เมื่อให้โปรแกรมทำงาน จะมีปุ่มปรากฏให้เลือกกด แล้วแสดงผลค้างไว้
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การสร้างการโต้ตอบ
การโต้ตอบแบบกดปุ่ม (Button) 
เป็นการโต้ตอมในรูปแบบของปุ่ม เพื่อให้ผู้ใช้คลิกเมาส์ที่ปุ่มตัวเลือกต่างๆ สัญลักษณ์ที่ใช้แทนการโต้ตอบแบบนี้ จะเป็นรูปสี่เหลี่ยมมุมมน    [image: image45.png]© & Button
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ดับเบิ้ลคลิกที่บริเวณ [image: image48.png]


จะปรากฏหน้าจอในการเซ็ตค่าต่างๆ
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การโต้ตอบแบบกำหนดจำนวนครั้ง (Tries Limit)  

เป็นการโต้ตอบในรูปแบบที่ต้องการกำหนดจำนวนครั้งในการตอบคำถาม สัญลักษณ์ที่ใช้แทนการโต้ตอบแบบนี้ จะเป็นรูปสี่เหลี่ยมมุมมน  [image: image50.png]* " Tiies Limit
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ดับเบิ้ลคลิกที่บริเวณ [image: image52.png]


จะปรากฏหน้าจอในการเซ็ตค่าต่างๆ
การโต้ตอบแบบกำหนดเวลา (Time Limit)  

เป็นการโต้ตอบในรูปแบบที่ต้องการกำหนดเวลาในการตอบสนอง สัญลักษณ์ที่ใช้แทนการโต้ตอบแบบนี้ จะเป็นรูปสี่เหลี่ยมมุมมน  [image: image53.png]@ & Time Limit




การโต้ตอบแบบกำหนดพื้นที่ (Hot Spot)  

เป็นการโต้ตอบในรูปแบบที่ต้องการกำหนดพื้นที่ในการตอบสนอง คือ ต้องคลิกในบริเวณที่กำหนด สัญลักษณ์ที่ใช้แทนการโต้ตอบแบบนี้ จะเป็นรูปสี่เหลี่ยมมุมมน  [image: image54.png]" Hot Spat.




การโต้ตอบแบบคลิกวัตถุ (Hot Object)  

เป็นการโต้ตอบในรูปแบบที่ต้องคลิกวัตถุก่อนถึงจะมีการตอบสนอง คือ ต้องคลิกในบริเวณที่กำหนด สัญลักษณ์ที่ใช้แทนการโต้ตอบแบบนี้ จะเป็นรูปสี่เหลี่ยมมุมมน  [image: image55.png]" Hot Object




การโต้ตอบแบบลากวัตถุ (Target Area)  

 
เป็นการโต้ตอบในรูปแบบที่ผู้ใช้สามารถลากเอาวัตถุไปวางไว้ยังตำแหน่งที่กำหนดบนหน้าจอได้ สัญลักษณ์ที่ใช้แทนการโต้ตอบแบบนี้ จะเป็นรูปสี่เหลี่ยมมุมมน  [image: image56.png]= " TargetArea




การโต้ตอบแบบเติมข้อความ (Text Entry)  

เป็นการโต้ตอบในรูปแบบที่ผู้ใช้เติมข้อความแล้วนำไปแสดงออกทางหน้าจอได้ สัญลักษณ์ที่ใช้แทนการโต้ตอบแบบนี้ จะเป็นรูปสี่เหลี่ยมมุมมน [image: image57.png]" TextEnty



 
การโต้ตอบแบบกดแป้นพิมพ์ (Keypress)  

เป็นการโต้ตอบในรูปแบบที่ผู้ใช้ต้องกดแป้นพิมพ์ตามที่กำหนดถึงจะมีการตอบสนอง สัญลักษณ์ที่ใช้แทนการโต้ตอบแบบนี้ จะเป็นรูปสี่เหลี่ยมมุมมน  [image: image58.png]e " Keypress




การใช้งานไอคอน ภาพยนตร์ เสียง และดีวีดี
[image: image59.png]


  Digital Movie Icon เป็นไอคอนสำหรับนำภาพยนตร์ที่สร้างไว้จากโปรแกรมอื่นเข้ามาแสดงในโปรแกรม
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  [image: image61.png]


  Sound Icon เป็นไอคอนสำหรับนำเสียงที่สร้างไว้จากโปรแกรมอื่นเข้ามาแสดงในโปรแกรม
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 DVD Icon เป็นไอคอนสำหรับนำวีดีโอที่สร้างไว้จากโปรแกรมอื่นเข้ามาแสดงในโปรแกรม
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ตัวอย่างการวางไอคอน
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การสร้างชิ้นงานด้วยเครื่องมือ Icon Palette

1. ทำการสร้างพื้นที่ทำงานใหม่โดยไปที่ File > New > File  เพียงเท่านี้ก็ได้พื้นที่ทำงานแล้ว
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2.ลาก Display icon มาวางบนเส้น Flowline แล้วทำการตั้งชื่อ icon เพื่อความสะดวกในการใช้งาน 
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3. ดับเบิ้ลคลิ๊ก  Display icon เพื่อนำไฟล์ภาพที่เตรียมไว้มามาใส่ในหน้ากระดาษ
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4. เลือกไฟล์ภาพที่ต้องการ โดยไปที่ Insert > Image > Import > เลือกไฟล์ภาพที่ต้องการ >  Import  แล้วคลิก OK จะได้ภาพที่ต้องการให้ทำการย่อหรือขยายขนาด ของภาพให้พอดีกับกรอบของ Display icon เพื่อความสวยงามของภาพ
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5. แทรกไฟล์ Flash  หรือ Animation gif เพื่อเพิ่มความน่าสนใจให้กับชิ้นงาน โดยไปที่ Insert > Media > Flash Movie > Browse > เลือกไฟล์ที่ต้องการ > Open ก็จะได้ไฟล์  Flash ที่ต้องการ
[image: image125.png]


[image: image126.png]


[image: image75.png]Authorwa

: [Untitled] *

Modfy Text Control Xtras Comm

Teon

Flash Move.

3

& %

Arimated GIF...

QuickTime...




        [image: image76.png]Flash Asset Properties (

Preview Not Available | Link File:

Lo ]
Media: ™ Linked I” Preload
intern
Cancel

Playback: ¥ Image I Paused
© Sound ® Loop
™ Direct to Screen
High -

[Auto-size -
Normal |15

Help





[image: image127.png]Untiled




[image: image77.png]Lookin: |2 v« @k
D [Fu Efer Szt
2 s Srear 2 aan
My Recent =) 3.50f ) hifias 1d.swf 2 unnla.swf
e el )logo_0s[].suf
@ = suf = nusnf
=] 7.50f =] oantiz.swf
Desidop | Ag.uf ] oantiz.swf
~ ] 11.mf ] oantisnf
w =] 3.0f ] aantiitusla_09.5f
=) 25.50F =) fudasuf
o1 ﬂ«mf ﬂada[l].swr
&) s0[1].swf 2] dusn.swf
T .
"’g’"‘ e Lo |
Files of type: |Shockwave Flash Files (".SWF) ~ Cancel





[image: image78.png]DU 157 10755 0 gasrs 5 9150 swr538833 33 5 935 181

O
B





6. วิธีตัดพื้นหลังของไฟล์ Flash ออก โดยดับเบิ้ลคลิกที่ Flash Movie จะปรากฏหน้าต่างขึ้นมาแล้วเลือกที่ Display ตั้งค่าMode เป็น Transparent  เท่านี้ก็จะได้ไฟล์ Flash ที่ไม่มีพื้นหลังแล้ว
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7. วิธีการสร้าง Main Menu ทำได้โดยการลาก Display icon มาวางบน Flow line  แล้วตั้งชื่อให้เรียบร้อย แล้วทำตามขั้นตอนข้อที่ 4 เพื่อใส่ Background ให้กับชิ้นงาน
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8. สร้างเงื่อนไขให้กับ Main menu  โดยลาก Interaction icon มาวางบน  Flow line  แล้วตั้งชื่อ จะได้ดังภาพ
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9. สร้างลิงค์ให้กับ Main Menu โดยลาก Map icon มาวางทางด้านขวาของ Interaction icon จนครบตามจำนวน ของ Main Menu ที่กำหนดไว้ดังภาพ
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10. กำหนดเงื่อนไขให้ตรงกับ Main Menu  ที่เราสร้างไว้  โดยดับเบิ้ลคลิกที่ไอคอน Menu เพื่อเปิด Background มากำหนดลิงค์แล้วคลิกบน Map icon เพื่อให้ปรากฎกรอบชิ้นงานแล้วปรับให้พอดีกับปุ่มไอคอนที่เราสร้างไว้ ดังภาพ
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หมายเหตุ : ให้ทำจนครบหมดทุกปุ่มที่เราสร้างไว้
11. เมื่อกำหนดการเชื่อมโยงครบหมดแล้ว ต่อไปสร้างเนื้อหาให้กับ Map icon โดยดับเบิ้ลคลิกที่ Map icon เพื่อวาง Display icon ลงบน Flowline แล้วดับเบิ้ลคลิกที่ Display icon เพื่อใส่ Background ให้กับชิ้นงาน ดังภาพ (ภาพที่นำมาใส่สามารถทำตามข้อที่ 4 ได้)
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12. สร้างลิงค์ให้กับปุ่มเพื่อกลับหน้า Menu โดยสร้าง icon แล้วดับเบิ้ลคลิกที่ Calculation icon  เพื่อสร้างเงื่อนไขในการลิงค์ไปยัง Menu โดยพิมพ์คำว่า GoTo (IconID@”Menu”) แล้ว save coad ไว้ดังภาพ
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13. สร้างเนื้อหาให้กับคำอธิบายรายวิชา,จุดประสงค์การเรียนรู้และแบบทดสอบให้ครบซึ่งวิธีการทำสามารถทำได้ในข้อ 11และ12 
14. สร้างการเชื่อมโยงให้กับปุ่มออกจากโปรแกรม โดยลาก Map icon มาวางทางด้านขวาของ Interaction icon แล้วดับเบิ้ลคลิกที่ Map icon แล้วนำ Calculation icon  มาวางบน Flowline แล้วกำหนดเงื่อนไขให้เรียบร้อย โดยใส่ coad Quit (0)  แล้ว save ไว้  จากนั้น นำ Calculation icon  มาวางข้าง Map icon แล้วกำหนดเงื่อนไขโดยใส่ coad GoTo(IconID@"menu")  จะได้ดังภาพ
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